Altera Quartus Modelsim

Ce “tuto” n’aborde que la partie simple de la simulation, ca permet de vérifier le bon fonctionnement du VHDL et de contrdler que les signaux soit bien conformes
pendant les divers changements d’états.

En premier lieux il faut bien configurer son projet Quartus.
pour ca dans les parametres du projet vérifier qu'il est bien indiqué dans EDA tool>Simulation = ModelSim-Altera (a modifier selon la version que vous utilisé de
Quartus).

Exemple sur mon projet SC3000/ORIC

+" Settings - SC3000_MEGA_Z O 4

Device...

EDA Tool Setfings

Specify the other EDA tools used with the Quartus Il software to develop your project.

Category:

General
Files
Libraries
“ QOperating Settings and Conditic
Voliage
Temperature
“ Compilation Process Settings
Early Timing Estimate
Incremental Compilation
Physical Synthesis Optimizat
“ EDA Tool Settings
Design Entry/Synthesis
Simulation

EDA tools:

Tool Name
Design Compile ~ VHDL =
ModelSim-Alter ~ VHDL

Tool Type Format(s) Run Tool Automatically

Run this tool automatically to synthesize the cL

Design Entry/.

Simulation

']] Run gate-level simulation automatically after c

Formal Verifi... =None=

Board-Level Timing STAMP

Farmal Verification
Board-Level

v Analysis & Synthesis Settings
VHDL Input

Symbol
Signal Integnty
Boundary Scan

<None>
<None>

<None>

Verilog HDL Input

Default Parameters
Fitter Settings
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap Il Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Setl
SSN Analyzer

w Buy Software Cancel Apply

Ensuite pensez a faire une compilation du projet sous Quartus pour que les fichiers nécessaires a la simulation soit générés.

Ouvrir ModelSim-Altera soit par le menu windows soit par l'icone “RTL simulation” dans Quartus.
Une fois ModelSim ouvert vous devrais voir dans la liste des librairies un dossier “work”, c’est dans celui la que vous devrais trouver tous vos projet.

On va compiler dans modelsim le projet, on appuie sur I'icone compile (1).

odelSim ALTERA JTARTER EDITION 10.1d
File Edit View Compile Simulate Add Library Tools Layoutf/Bookmarks Window Help

ME || SE R Bt e | 5[ 0008 ELE
vl || oot ‘a-g@-3

Jmsi@H tatiiat
S| FEEE s

‘ ColumnLayout [A11Columns

| % &l 4 2

C:/alteraf13,0sp1/work

$MODEL_TECH].. faltera/vhdl/220model
$MODEL _TECH)/.. faltera/verilog/220model
$MODEL_TECH/.. faltera/vhdl/altera
$MODEL_TECH)/. . /altera/vhdl/altera_lnsim
$MODEL_TECH)/.. faltera/verilog/altera_Insim
SMODEL _TECH)/.. faltera/vhd|/altera_mf
SMODEL _TECHY/.. faltera/verilog/altera_mf
SMODEL _TECH)/.. faltera/verilog/altera
SMODEL _TECH).. faltera/vhdi/altgxb

$MODEL _TECH/.. faltera/vhdl/altgxb
$MODEL_TECH)/. . faltera/verilog/altgxb
$MODEL_TECH/.. faltera/vhdl/arriagx
$MODEL_TECH/. . faltera/vhdl/arriagx_hssi
$MODEL_TECH].. /altera/verilog/arriagx_hssi
$MODEL_TECH/.. faltera/verilog/arriagx
SMODEL_TECH)/.. faltera/vhdl/arriaii
$MODEL_TECH].. faltera/vhdl/arriaii_hssi
$MODEL_TECH/.. /altera/verilog/arriaii_hssi
$MODEL_TECH)/. . faltera/vhdl/arriaii_pcie_hip
$MODEL_TECH/.. /altera/verilog/arriai_pcie_hip
$MODEL_TECH/.. faltera/verilog/arriail
$MODEL_TECH]../altera/vhdl/arriaiigz
$MODEL_TECH].. /altera/vhdl/arriaiigz_hssi
$MODEL_TECH].. faltera/verilog/arriaiigz_hssi
$MODEL_TECH].. faltera/vhdl/arriaiigz_pcie_hip
$MODEL _TECHY.. /altera/verilog/arriaiigz_pcie_hip
$MODEL _TECH)/.. faltera/verilog/arriaiigz
$MODEL _TECH].. faltera/vhd/arriav

$MODEL _TECH].. faltera/verilog/arriav_hssi
$MODEL_TECH]..faltera/verilog/arriav_pcie_hip
$MODEL_TECH)/.. altera/verilog/arriav
$SMODEL_TECH/.. faltera/vhdl/arriavgz

Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library
Library

-} altera_lnsim
altera_lnsim_ver
altera_mf
altera_mf_ver
altera_ver
altgxb

altgxb_lib
altgxb_ver
arriagx
arriagx_hssi
arriagx_hssi_ver

arriagx_ver
arriai

arriaii_hssi
arriaii_hssi_ver
arriaii_pcie_hip
arriai_pcie_hip_ver
arriaii_ver

arriaiigz
arriaiigz_hssi
arriaiigz_hssi_ver
arriaigz_pdie_hip
arriaiigz_pcie_hip_v...
arriaiigz_ver

arriav
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il arriav_hssi_ver (e...

i} armiav_pce_hip_ver...

Hil arriav_ver (empty)
-l arriavgz

A Transaipt
¢ -- Compiling entity SC3000_MEGA_Z
# -- Compiling architecture structure of SC3000_MEGA Z

VSIM 5>

Now: 0ps Delta: 0 \snm:/scmoo_mega_z
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$MODEL_TECH)/../altera/verilog/220model

$MODEL_TECH..faltera/vhdl/altera " . 2 g

SMODEL TECH/. /ateralvhd/atera nsin Ouvrir le répertoire du projet

$MODEL_TECH/.. /altera/verilog/altera_Insim A - ¥
SHODEL TECH. alerafvhdatera.m et explorer dans simulation/modelsim
$MODEL _TECH]../altera/verilog/altera_mf

$MODEL_TECH/. . /altera/verilog/altera

$MODEL_TECH/../altera/vhdl/altgx }§ Compile Source Files

Library: work I

a¢ Regarderdans :...\Projetnameisimulation\modelsim <« & £5 B~

A

* Nom Modifié le

|| rtl_work 02/01/2018 22:46
Accés =
ke | work

02/01/2018 22:46
0 SCJm_MEGA_‘q_ 1 14/01/2018 16:23

<
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C:/altera/13.0sp1/work
doubleclick
$MODEL_TECH/.. falterafvhd|/220model
$MODEL_TECH/.. /altera/verilog/220model
$MODEL_TECH/.. falterafvhdl/altera
$MODEL_TECH/. . /altera/vhdl/altera_lnsim
$MODEL_TECH/.. /altera/verilog/altera_lnsim
$MODEL_TECH/.. falterafvhdl/altera_mf
$MODEL_TECH/.. /alterajverilog/altera_mf
$MODEL_TECH|.. /altera/verilog/altera
$MODEL_TECH/.. /altera/vhd/altgxb
$MODEL_TECH/. . /alterajvhdl/altgxb
$MODEL_TECH|.. /altera/verilog/altgxb
$MODEL_TECH/.. faltera/vhd/arriagx
$MODEL_TECH/. . /altera/vhdlfarriagx_hssi
$MODEL_TECH/.. /altera/verilog/arriagx_hssi
$MODEL_TECH/.. faltera/verilog/arriagx
$MODEL_TECHY/.. /alteravhd/arriaii
$MODEL_TECH/.. /alterafvhdl/arriaii_hssi
$MODEL_TECH]../altera/verilog/arriaii_hssi
$MODEL_TECH)/.. falterafvhdl/arriaii_pde_hip
$MODEL_TECH/.. /altera/verilog/arriai_pcie_hip
$MODEL_TECH)/.. Jaltera/verilog/arriai
$MODEL_TECH/.. /alterajvhdl/arriaiigz
$MODEL_TECH/. . /altera/vhdl/arriaiigz_hssi
$MODEL_TECH|.. /altera/verilog/arriaiigz_hssi
$MODEL_TECH/.. /altera/vhdl/arriaiigz_pdie_hip
$MODEL_TECH/.. /altera/verilog/arriaiigz_pcie_hip
$MODEL_TECH/.. /altera/verilog/arriaiigz
SMODEL_TECH/.. /altera/vhdl/arriav
$MODEL_TECH/.. /altera/verilog/arriav_hssi
$MODEL_TECH/.. faltera/verilog/arriav_pde_hip
$MODEL_TECH/.. /altera/verilog/arriav

¢ —- Compiling entity SC3000_MEGA_Z
# —— Compiling architecture structure of SC3000_MEGA Z
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De nouvelles fenétres doivent s’ouvrir avec les sighaux disponibles(objects), les processus (processes), et la partie analyse (wave).
Pour commencer vous devez faire glisser les signaux que vous voulez analyser vers la fenétre wave.

Il est possible de rajouter ou d’enlever des signaux au fur et a mesure de I'exécution de la simulation.
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Fd Transcript Eoes HA X
sim:/sc cc e |
ze sim:/sc300
sim:/ 000_mega_z/\CH376_/CS\
VSIM 68 > s
Now: Ops Delta: 0 sim: fsc3000_mega_z Opsto 896 ps

Une fois tous les signaux sélectionnés il faut les configurer pour pouvoir les simuler et analyser leurs comportements.




Il y a plusieurs type de signaux en entrées (IN), en sorties (OUT) et bidirectionnel (BIDIR), un icone devant chaque nom de signaux indique le sens des signaux.
Je conseil de toujours parametrer le signal VCC a 0 pour le début de la simulation, ca permet de commencer la simulation en simulant I'arrét de la machine.
Ensuite paramétrez tous les signaux IN et laisser les signaux OUT dans I'état il seront mis a jour par le simulateur.

Je conseil d'utiliser le mode pas a pas qui est a mon avis le plus pratique pour de petits montages (décodage d’adresse, bascule, ...)

pour ca vous devez si besoin modifier la valeur du pas d'exécution de la simulation dans la partie entourée en rouge dans I'image ci dessous.

Dans mon exemple j'ai simulé un décodage d’adresses et une pagination sur de la RAM et de la ROM en utilisant les 1/0 (A8-A0) pour le Z80, la page 2 (A15-A0) pour
le 6502.
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p=d Transcript PO HdA X
add wave -position 0 sim:/sc3000 o
force e 5im:/sc300
add wave -position end H376 S
VSIM 68> x
Now: Ops Delta: 0 .Sfmflw"SCEF]L)']_mEQE_Z [0 ps to 896 ps

On peut gérer plusieurs curseurs pour marquer différents états/temps, ainsi que de modifier I'affichage de la partie “wave” (unité de temps, taille de la grille,...).
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P Transcript

M Force Selected Signal

Signal Name: I:'lm :/3c3000_mega_z/vece

Value: |1

* Freeze " Drive Deposit

Delay For: |0

Cancel After:

¥|Instance Desic_* ‘ ¥|Name il < } : [
—-Jll sc3000_mega_z sc300 ') 75C3000_mega = = | Global Signal Radix....
+ [l A[15]~1\ max_ - 1’ = = Object Dedaration J Symbolic
VA[3]~T\ max_ — - L
-l AL~ ‘ ax_ B fsc3 Add » Binary
-l A[15]~22) max_ £ fsc0
+ [l AL ~T\ max_ ™ Edit > Octal
. View » Decimal
+ VA[7]~T\ max_ ey
i : \A[G]~T max - _// Unsigned
i 3 ¢ sC3( Radix 4
+ [l A5~ max Hexadecimal
B AT i ¢ Format > ASCIT
+ \A[4]~I\ max_ =
=+l '\Pagination_RAM[15~1... max_ 3 Combine Signals... Time
+- [l Pata[3]~1\ max_ ‘¢ Group... Fixed Point...
-l W~ max_ & 530 Use Global Radix
+ Il \A[0]~1\ max_ _¢
&+l VIOwr~I\ max_ .¢ ' x Force... \ Numeric Enums
+- [l \Pagination_RAM|15~6\,..max_ P NoForce L‘ Symbolic Enums
++ Il Vnst19~1\ max_ Clock...
+- [l \Pagination_ROM|15~1... max_ Propertiss...
++ 8 'Pagination_ROM|15~6... max_
+- [l VIOwr~1\ max_ \
+- 1l VIOrd~T\ max_
+- 1l ViOrd~1\ max_ — .
2 \AO]~24\ max_ M Define Clock
+- [l \A[15]- max_ Clock Name
+- Il W2 max_ lsu.:_'scaiw-]w]_mega_:"m::
+- [l A3 max_
=l A4 max_ offset Duty
+ 1l A1 max_ T &h
Y AE max_ = =
+- [l \AE \ max_ ‘4 3]
Period Cancel
\A[7] ~38) max >
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oMl \Al8l~40\ — ¥|Name Type (filtered) |state | =]
+- [l \A[G]~T\ max_ 9 = Logic Values
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+ I\ max_ = {+ Rising Falling
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add wave -position end sim:/s

-position end sim:/s

Now: 0 ps Delta: 0 sim:/sc3000_mega_z/vcc

Opsto470ps

La configuration des signaux permet de définir leurs états et leurs représentations ainsi qu’'un comportement “scripté” (clock, valeur pendant x delay;, ..

définir des couleurs différentes pour une meilleur visibilité.

Pour commencer je conseil de définir les radix sur hexadécimal pour les adresses et datas c’est plus pratique a mon sens pour suivre les résultats, mais vous pouvez

laisser sur binaire si cela vous arrange.

Ensuite on peut forcer un signal a une valeur donné ou configurer une valeur pendant un délai défini.

On peut aussi attribuer une horloge (clock) a un signal et définir les delay et le sens du front de démarrage.

.), ainsi que

Chaque signal doit étre paramétrés au cours de I'exécution de la simulation si I'on veut pouvoir simuler les changements d’états des divers signaux d’entrées et

visualiser les comportements des signaux de sorties.
Donc pour commencer forcer le signal VCC a 0.

Et configurez tous les signaux IN comme vous le souhaitez .



Commencons la simulation en appuyant sur l'icone pas a pas.
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f 3c3000_mega_z IOwr 10 |
VSIM 44>

Now: 100 ps Delta: 0 /sc3000_mega_z/A [15:0] 0 ps to 896 ps

Comme nous avons défini VCC a 0 les signaux en sorties sont dans un états indéfinis ce qui est normal ;)

Le curseur peut étre placé n'importe ou sur la base de temps, dans la partie gauche vous pouvez lire I'états des signaux correspondant au curseur.

Maintenant forcez le signal VCC a 1, et cliquez sur I'icone pas a pas pour faire avancer la simulation d’un pas.
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force -freeze sim:/sc3000_mega_

VSIM 45> run

VSIM 46>

Now: 200 ps Delta: 0 sim: /sc3000_mega_z 0 ps to 896 ps

On peut voir que tous les signaux en sorties on changés d’états, ca nous permet de vérifier que lors du démarrage les signaux sont bien aux niveaux attendus, sinon il
faut modifier le code VHDL ou le shémas et recompiler dans Quartus et ModelSim et relancer une simulation .

Le principe est simple on modifie 1 ou plusieurs signaux et on clique sur pas a pas pour visualiser le comportement des divers signaux.



Voici un petit exemple en ayant modifié plusieurs fois I'état des signaux d’entrés, on voie bien que les sorties réagissants conformément aux signaux d’entrées :
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$a objects i H & x| | gm| Wave -Default
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/sc3000_mega_z/Rom_PageAl
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%¥ Processes (Active)
¥ Name | Type (filtered)

VSIM 84> run

VSIM 85>

Now: 600 ps Delta: 0 sim: fsc3000_mega_z 0 ps to 896 ps

Maintenant on peut modifier chaque signal pour vérifier tous les cas possibles et vérifier que les signaux se comportent de maniéres attendu.

Ce n’est pas une simulation absolue, mais ca permet de vérifier le bon fonctionnement et les différents cas possible.

Dans I'exemple choisi j'ai pris des timing évidemment pas réaliste mais le but est de vérifier que les changements d’états soi conformes, évidemment on pourrait
utiliser des timing réaliste en ns ou us, mais c’est trés difficile de connaitre le timing exacte de la machine cible en exécution.

Il y a beaucoup d’option a vous de découvrir celle qui peuvent vous étre utile selon vos projets ;)



